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1 General Information

The ASCET product family provides an innovative solution for the functional
and software development of modern embedded software systems. ASCET
products support every step of the development process with a new approach
to modelling, code generation and simulation, thus making higher quality,
shorter innovation cycles and cost reductions a reality.

This manual describes the installation of ASCET products. The products them-
selcves are described in manuals or online help files.

1.1 About this Manual

The ASCET installation guide contains the following chapters:

• "General Information" (this chapter)

This chapter provides some basic information regarding this manual.

• "Program Installation"

This chapter targets both all users who install, maintain or uninstall 
ASCET on a PC or a network as well as system administrators who pro-
vide ASCET on a file server so that the program can be installed via the 
network. It contains important information on the scope of delivery, 
hardware and software requirements for stand-alone and network 
installations and the preparation required for installation. The chapter 
also describes the procedures used to install and uninstall ASCET.

• "Licensing"

This chapter contains various licensing information, e.g. how to obtain 
a license file or how to borrow a license.

• "ETAS Contact Addresses"

Contact information of the various ETAS subsidiaries.

1.2 Documentation Conventions

All actions to be performed by the user are presented in a a task-oriented for-
mat as illustrated in the following example. A task in this manual is a sequence
of actions that have to be performed in order to achieve a certain goal. The
title of a task description usually introduces the result of the actions, e.g. "To
create a new component", or "To rename an element". Task descriptions
often contain illustrations of the particular ASCET window or dialog box the
task relates to.
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To achieve a goal:

Any preliminary information...

• Step 1

Explanations are given underneath an action.

• Step 2

Any explanation for Step 2...

• Step 3

Any explanation for Step 3...

Any concluding remarks...

1.3 Typographic Conventions

The following typographic conventions are used in this booklet:

Important notes for the users are presented as follows:

Select File → Open.
Click OK.

Menu commands and buttons are shown in 
blue boldface.

The "Open File" dialog win-
dow opens.

Names of program windows, dialog windows, 
fields, etc. are shown in quotation marks.

Select the file setup.exe. Text in drop-down lists on the screen, pro-
gram code, path- and file names are shown in 
the Courier font.

The OSEK group (see 
http://www.osekvdx.org/) has 
developed certain standards.

Links to internet documents are set in blue, 
underlined font.

Note

Important note for users.
General Information



2 Program Installation

The chapter entitled "Program Installation" targets both all users who install
ASCET on a PC or a network, or maintain and uninstall the program as well as
system administrators who provide ASCET on a file server so that the program
can be installed via the network. It contains important information on the
scope of delivery, hardware and software requirements for stand-alone and
network installations and the preparation required for installation. The chapter
also describes the procedures used to install and uninstall ASCET.

2.1 Preparation

Check the items supplied for completeness and your computer for compliance
with the system requirements. Depending on the operating system used and
the network connection, you have to make sure that you have the user privi-
leges required.

2.1.1 Contents

ASCET is supplied with the following:

• ASCET CD ROM

– ASCET program files

– ASCET manuals and ETAS hardware documentation in PDF format 
(Acrobat Reader)

– Manual "FLEXnet Licensing End User Guide" in PDF format 

– Acrobat Reader program files

Furthermore, you require a valid license for the use of ASCET products. You
can obtain the license files required for licensing either from your system
administrator or through a self service portal on the ETAS Internet Site; the URL
is given in the entitlement letter. To request the license file you have to enter
the activation number which you received from ETAS during the ordering pro-
cess.

2.1.2 System Requirements

The following system requirements have to be met:

• 1 GHz Pentium PC (recommended: 2 GHz)

• WINDOWS® 2000, WINDOWS® XP, WINDOWS® Vista

• 512 MB RAM (recommended: 512 MB) 

• Hard disk with a minimum of 1 GB of free space (not incluging space 
for program data; recommended: > 1 GB)
Program Installation 7
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• CD ROM drive

• VGA graphics card with VGA monitor and a resolution of at least 800 
x 600 with 256 colors

2.1.3 Required User Privileges for Installation and Operation

User privileges required for installation:

In order to install ASCET on a PC, you need the user privileges of an adminis-
trator. Please contact your system administrator, if necessary.

User privileges required for operation:

In order to operate ASCET, each user must receive the privilege called
"Increase Scheduling Priority" from the administrator. This can be set using the
User Manager.

Recommendation: Assign the privilege "Increase Scheduling Priority" to the
local "User" group. To do so, proceed as follows:

To assign WIN 2000 – User Privilege "Increase Scheduling Priority":

• From the Windows Start Menu, choose 
Settings → Control Panel → Administra-
tive Tools → Local Security Policy.

• Under Local Policies → User Rights Assign-
ment activate Increase scheduling 
priority by double-clicking on it.

• Click on the Add button. 

• Select the local workstation.

• Assign the "Increase Scheduling Priority" priv-
ilege to the User group by double-clicking on 
it. 

• Confirm by clicking the OK button.

• Close the "Local Security Policy" window by 
clicking OK.

• Exit the local security policy settings.

Note

You need administrator rights to perform the settings described below.
Program Installation



To assign WIN XP – User Privilege "Increase Scheduling Priority":

• From the Start Menu, choose Settings → 
Control Panel → Administrative Tools → 
Local Security Policy.

• Under Local Policies → User Rights Assign-
ment activate Increase Scheduling 
Priority by double-clicking on it.

The "Increase scheduling priority Properties" 
window is displayed.

• Click on the Add User or Group button.

The "Select Users or Groups" window is dis-
played.

• Click on the Locations button.

The "Locations" window is displayed.

• Select the local workstation and close the 
"Locations" window by clicking OK.

• In the "Select Users or Groups" window, click 
on the Advanced button to enable the auto-
matic search feature.

• Click on the Find now button to display the 
list of users registered for the local worksta-
tion.

• In the "Name (RDN)" column, choose the 
names of the users or groups to whom you 
want to assign the privilege to increase the 
scheduling priority.

• Confirm by clicking the OK button. 

• Close the "Select Users or Groups" window 
by clicking OK.

• Close the "Increase scheduling priority Proper-
ties" window by clicking OK.

• Exit the local security policy settings.

To assign WIN Vista – User Privilege "Increase Scheduling Priority":

• From the Start Menu, select Control Panel → 
System and Maintenance → Administra-
tive Tools → Local Security Policy.
Program Installation 9
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• Under Local Policies → User Rights Assign-
ment activate Increase Scheduling 
Priority by double-clicking on it.

The "Increase scheduling priority Properties" 
window is displayed.

• Click on the Add User or Group button.

The "Select Users, Computers or Groups" 
window is displayed.

• Click on the Locations button.

The "Locations" window is displayed.

• Select the local workstation and close the 
"Locations" window by clicking OK.

The "Select Users, Computers or Groups" 
window is renamed to "Select Users or 
Groups".

• In the "Select Users or Groups" window, click 
on the Advanced button to enable the auto-
matic search feature.

Another window named "Select Users or 
Groups" opens.

• Click on the Find now button to display the 
list of users registered for the local worksta-
tion.

• In the "Name (RDN)" column, choose the 
names of the users or groups to whom you 
want to assign the privilege to increase the 
scheduling priority.

• Confirm by clicking the OK button. 

• Close the first "Select Users or Groups" win-
dow by clicking OK.

• Close the "Increase scheduling priority Proper-
ties" window by clicking OK.

• Exit the local security policy settings.
Program Installation



2.2 Installation

To install one of the add-on products (e.g., ASCET-MD, ASCET-RP, ASCET-SE,
ASCET-SCM), you have to install the ASCET base system first. ASCET-SCM
requires, in addition, the installation of either ASCET-MD, ASCET-RP or
ASCET-SE.

Installation is performed in the same way if you install ASCET from the CD or
the network drive.

Chapter 2.2.1 describes the installation of the base system in detail. The instal-
lation of add-on producs is briefly described in chapter 2.2.2; if additional
information is required, see the respective manuals or release notes.

Special issues to be observed during the installation (e.g., "Canceling the
Installation" or "Overwriting an Existing Program Version") are described in
chapter 2.2.3 on page 19. Chapter 2.2.4 contains information on command-
line installation.

2.2.1 Initial Installation – ASCET Base System

To start the ASCET installation:

• Insert the installation CD into the CD drive of 
your computer.

• If the CD does not start automatically, double-
click on start.exe.

An installation dialog opens.
Program Installation 11
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• Click on the ASCET link to install the ASCET 
base system.

• The installation starts.

Follow the instructions:

• In the "EULA" window, activate the Accept 
option to accept the license agreement.

• Click OK.

• Follow the instructions displayed on the 
screen.

The Next button accepts your settings and 
proceeds to the next window, the Back but-
ton returns to the previous window, and Can-
cel aborts the installation. 

To register ASCET:

• In the registration window, enter your per-
sonal information.

Note

You must install the ASCET base system before 
you can install ASCET-MD or any other ASCET 
procuct except ASCET-DIFF.
Program Installation



• Click on the Next button.

To specify ASCET paths:

When you have registered ASCET, you will be prompted to specify target direc-
tories for the data. This is done in two separate windows:

Program files and program data are stored in different directories. When you
uninstall or update the program later, only the program files will be deleted or
overwritten. The program data will continue to be available to you. The pro-
gram data includes the following:

• Databases

• User profiles

• If you want to change the default directories, 
click on the Browse button.

• In the dialog box, select the desired directory.

If you specify a directory which does not exist, 
the installation routine will automatically cre-
ate it.

Note

You can install ASCET in a directory with blanks in it’s path. Before you do 
so, however, make sure that all external tools used with ASCET support path 
names with blanks, too.
Program Installation 13



14
• Click on the Next button.

The "Select global directories" window opens. 
Here, you can specify paths for log files and 
temporary files. These paths are used by all 
ETAS products.

• Use the Browse buttons to adjust the paths 
settings according to your wishes.

• Click on the Next button.

Settings for common files:

In the "Select Handling of ETAS-Shared modules" window, you specify the
way the modules used in principle by all ETAS products are installed.

• Activate the share modules between prod-
ucts option when the modules are to be con-
jointly used.

This is reasonable when you intend to use sev-
eral ETAS products simultaneously.

• Activate the use local copies for each prod-
uct option when ASCET shall be installed with 
its own copies of the modules, e.g., when you 
intend to adjust the components.

• Click on the Browse button to adjust the path 
settings for the modules.

• Click on the Next button.
Program Installation



To specify the ASCET functional scope:

In the "Select options" window, you can specify the functional scope of
ASCET.

• Mark the modules you want to install.

The following options can be selected:

– AS-Editor – the arithmetic services editor.

– ASD-Database – installs the ETAS system 
library and tutorial database in the export 
directory of your ASCET installation.

– ASD-Manual – installs the ASCET manu-
als as PDF files in the ETAS\ETASManu-
als directory.

– ASD-OnlineHelp – the ASCET online help 
is placed in the ETAS\ASCET6.0\help 
directory.

– ASD-ToolAPI – installs the ASCET Auto-
mation interface.

• Click on the Next button.
Program Installation 15
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To specify the ASCET folder in the Start menu: 

• Accept the default folder name

or

• specify a different folder name.

• Click on the Next button.

Installing ASCET:

• In the "Ready for installation" window, click 
Next to start the installation. 

The program files will be copied. A bar chart 
indicates the copy progress.

If necessary, the ETAS license manager is 
installed with the program.

Finally the "Installation complete" window 
appears.

Note

With the next step, you start the installation.
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• In the "Installation complete" window, click 
on the Finish button to finish the installation.

After restarting your PC, you will find the folder name you specified with the
following entries in the Start menu: 

• ASCET Help

Opens the ASCET online help.

• ASCET Uninstall

Starts the uninstall routine (see chapter 2.5).

• ASCET V6.0

Starts the ASCET program.

• AS Editor 

Starts the AS Editor (see ASCET online help for more information).

• ETAS Network settings

Starts the assistant for the configuration of the ETAS network.

• LicenseInfo

Starts the "Obtain License Info" window (cf. chapter 3).

• Online manuals

If you installed the online manuals, you can here open the 
ETAS\ETASManuals directory. Here, the manuals are stored in sev-
eral subdirectories.

• PC RemoteControl

Enables the configuration of the remote interface.

• ReadMe

Provides current information on ASCET V6.0.

The ETAS License Manager has a separate folder License Management in the
ETAS program group of the Start menu.

Three sample files are located in the export directory of your ASCET installa-
tion; they are available as *.exp or *.aml files. They can be imported in any
ASCET database.

• SystemLibETAS.* and ETASSystemLibCT.* – ETAS system 
libraries (containing various basic modelling blocks such as the PT1 ele-
ment or other basic filter elements, integrators, etc.)

• Tutorial.* – ETAS tutorial 
Program Installation 17
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2.2.2 Installation – ASCET-MD and Other ASCET Products

After installing the basic system, you can install ASCET-MD or other ASCET
add-on products.

To install ASCET add-ons:

• Re-open to the installation dialog.

• Click on the ASCET-MD link (or the link of 
another ASCET product you want to install).

• Follow thwe instructions on the installation 
dialogs.

The selected product is installed.

Note

You must install the ASCET base system before 
you can install ASCET-MD or any other ASCET 
procuct except ASCET-DIFF.
ASCET-SCM can only be used if ASCET-MD, 
ASCET-SE or ASCET-RP is installed, too.
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2.2.3 Special Installation Steps and Dialogs

To cancel the installation:

Before you click Next in the "Ready for installation"window, you can still can-
cel the installation prematurely. Proceed as follows:

• Click the Cancel button in the current win-
dow.

• Click Resume to return to the previous dialog 
box.

• Click the Exit Setup button to quit the setup 
program.

• Confirm that you want to cancel the installa-
tion by clicking OK.
Program Installation 19
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To overwrite an existing program version:

If an older version of the software to be installed is found on the target work-
station, or if an entirely different software exists in the selected installation
directory, a corresponding dialog box appears. The following sample dialog
box would appear during the installation of Version 6.0.0, if (beta) version
6.0.0b1 would have already been installed on the target workstation.

• Read the instructions carefully. 

You are informed that an older installation has 
been found, and that files will be overwritten 
when you continue.

• To select a different directory, click the Back 
button.

• If you want to overwrite the existing files, click 
the Yes, overwrite it button.
Program Installation



• Acknowledge the confirmation prompt by 
clicking Yes, overwrite it!

Click No to return to the previous window.

To overwrite existing directories:

If the directories specified during the installation already exist, and a complete
ASCET installation does not exist on the target workstation, the following dia-
log window appears. This case occurs, e.g., if a previous installation process
has been canceled.

• Read the instructions carefully. 

You are informed that the directory you 
selected already exists.

• To select a different directory, click the Back 
button.
Program Installation 21
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• If you want to overwrite the existing directo-
ries, click the Yes, overwrite it button.

• Acknowledge the confirmation prompt by 
clicking Yes, delete all!

ASCET is installed; existing files are deleted.

Click No to return to the previous window.

Performing an installation without administrator privileges:

This message box appears if the user name under which you logged on to
Windows has no administrator privileges. After you acknowledge the mes-
sage, the installation is terminated because administrator privileges are pre-
requisites for the installation of ASCET.

• Confirm by clicking OK. 

This installation is terminated. 

• Please contact your system administrator. 

• Try the installation again after you have 
received the required privileges.

2.2.4 Command Line Installation

When you start the inspallation from a command line, you can use several
command line arguments to customize the installation.
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/silent or /s

Silent installation mode. With this installation mode, no dialog win-
dows requiring user information open. Default values, or values from 
the install.ini file, are used for all information normally requested 
in installation windows. Error messages are hidden, too.

Silent installation is started as hidden process. An icon appears in the 
system tray during installation, but you cannot access the process.

A log file silent.log is created in the ASCET installation directory. It 
uses the *.ini file format with a section for each ASCET product 
installed in silent mode. As long as the installation is running, the 
respective section contains a line

install=in progress

After a successful installation, that line is changed to 

install=successfully finished

If a reboot is required after installation, the reboot is performed auto-
matically, unless you prevent it by an entry1 in install.ini. The fol-
lowing line is added to the respective section in any case:

need reboot=yes

/basic

Basic installation mode. In this installation mode, no dialog windows 
requiring user information open, except the EULA window. The basic 
installation mode works as the silent installation mode, except that ani-
mations, the progress bar and error messages are shown and no log file 
similar to silent.log is created.

1. [SilentInstallation]
;prevents a silent installation from rebooting when
;set to "Suppress"
Restart=Suppres 

Note

/silent must be the first command line argument. If other arguments 
precede it, /silent has no effect.

Note

For some ASCET products, environment variables can be defined, or prefer-
ences mus be set in the install.ini file to control silent or basic installa-
tion. See the respective documentation for details.
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24
/ini="<MyPath>\<IniFileName>.ini"

By default, the install.ini file in the installation file directory is 
used for installation. It may be reasonable, however, to use different 
installation *.ini files for different installations, e.g. if several custom-
ers install ASCET products from one central share. 

If an installation *.ini file is located outside the installation file direc-
tory, it is accessed via /ini="<MyPath>\<IniFileName>.ini". 

If an installation *.ini file is located inside the installation file direc-
tory, it is accessed via /ini=".\<IniFileName>.ini".

/? /h

Opens window with the valid command line arguments.

2.3 Network Installation

In addition to the installation from the CD, you can also install ASCET from a
network drive on the PC. 

The network installation provides the benefit that you can adjust data even
before the actual installation on the workstation takes place (see section
2.3.2).

2.3.1 Providing Data in the Network

To provide data in the network, you have to copy the installation files from the
CD to the desired network drive. 

To provide data on the network server:

• Create a source directory on the desired net-
work drive.

• Copy all data from the CD to the source direc-
tory.

Installation Log

The network installation of a user is logged in a file on the network. Therefore,
all users need write access to the x:\user directory or to the directory speci-
fied in install.ini for the registration.

2.3.2 Customizing the Network Installation

You can customize ASCET (modifying specific default settings) even before the
user installs ASCET on his workstation.

You have the following customizing options for the network installation:
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• You can customize the installation dialogs (modifying the default set-
tings for, e.g., directories, etc.).

• You can perform the ASCET installation fully automatically and without 
user intervention invisibly in the background. 

• You can overwrite the files provided in the product data directory 
(default setting: [drive]:\ETASdata\ASCET6.0\...) with your 
customized files and/or add files to the existing directories.

Customizing Installation Dialogs

For the network installation in large enterprises, it is often necessary to cus-
tomize certain default settings during the installation to fit internal standards
and requirements. This is possible by means of the install.ini configura-
tion file. This file is located in the installation directory. 

The following example will show you how to modify the default settings.

To customize the configuration file:

• Open the install.ini file with a text edi-
tor.

The following is a typical example of an entry 
in this INI file:

;Sets the main directory of ASCET

;MainDir=c:\etas\ASCET6.0

• To modify the default setting, delete ";" (com-
ment) on the line with the MainDir keyword.

• Change the path to, e.g., 
H:\programs\etas\ASCET6.0.

The entry should now look like this:

;Sets the main directory of ASCET

MainDir=H:\programs\etas\ASCET6.0

• In the same way, modify all other entries in 
install.ini as desired.

• Save your changes and then close the editor.

When you now start the installation with Ascet.exe, the dialog boxes will
show the new settings as defaults.

Note

The modified path settings affect the functions described below.
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Automatic Installation

By calling Ascet.exe /s you can execute the ASCET installation fully auto-
matically and transparently in the background, i.e., without any required user
interaction. This will select the currently valid default settings. You can config-
ure these settings in the install.ini file (see "Customizing Installation Dia-
logs" on page 25). 

If you as the system administrator create a batch file containing the
ascet.exe /s command, and configure the required settings in
install.ini, the users can run the installation process themselves by exe-
cuting this batch file without the need to enter any further information. 

As this type of installation does not display any dialog boxes, you may want to
provide some mechanism to inform the user when the installation has finished.

Customizing ASCET Files

The customization feature described below allows you to control the installa-
tion routine so that certain default files are overwritten with your customized
files during the installation, or that other files are included in the installation.

In this way, you can integrate your customized databases, user profiles, and
window templates in the installation routine.

The mechanism is relatively simple. Create a subdirectory named
InstData\... in the installation directory and copy your customized files
into it while maintaining the proper directory structures.

To create your customized files, install ASCET on a test computer, and use this
to create the files.

After the default installation of ASCET, the ETASData\ASCET6.0\...
directory contains various subdirectories with files that determine the ASCET
default settings which you can customize. These include the following subdi-
rectories: 

• Database\DB\ 

The db subdirectory contains the default database. Here you can, e.g., 
create another demo database under Database\DemoDB\.

• User\[user name], depending on the windows login

The [user name] subdirectory contains the default user profile. All 
configurable options are stored in this subdirectory.

Customizing Data for Network Installation:

• Install ASCET on your PC.

• Start ASCET.
Program Installation



• Modify the user profile. 

• Modify the database or add a new database.

• Exit ASCET.

You have finished your customization and now want to integrate these files in
the installation routine. You have two choices.

• Overwrite existing files having the same name with your customized 
files. To be able to do this, you must create a folder named Inst-
Data\overwrite\ in the installation directory. 

• Rename your customized files and add them to the existing files. There 
are no files with the same name that will be overwritten. To be able to 
do this, you must create a folder named InstData\add-only\ in 
the installation directory. 

To include your customized files in the installation routine, be sure to copy also
the parent directories. Note that the ETASData\ASCET6.0\ directory level
must be the same as InstData\overwrite\ or InstData\add-only\. 

Examples: 

InstData\overwrite\user\userDef.ini

InstData\add-only\database\additionalDB\

To integrate a modified user profile:

• Copy your customized file 
ETASData\ASCET6.0\user\[user 
name]\Ascetsd.ini into the 
InstData\overwrite\user\ subdirec-
tory.

• Rename the Ascetsd.ini file to user-
Def.ini.

This ensures that this initialization file will be 
used after the installation for each new user.

To integrate a modified database:

• Copy your customized database, i.e., the 
\database\DB\ subdirectory into the 
InstData\add-only\... subdirectory.
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• Rename the db directory as desired, otherwise 
the database will not be copied. 

Of course, you could also overwrite the db 
database by using the InstData\over-
write\ directory.

When starting the installation routine with ascet.exe, the default files will
be replaced with your customized files and/or your new files will be added in
the corresponding directories.

2.3.3 Installing ASCET from the Network Drive

The installation from a network drive is described under "Installation"
on page 11. You only need to know on which drive and in which source direc-
tory the installation files are located.

Note

To install ASCET from a network drive, you need write access to the log 
directory on the network drive (see chapter 2.3.1).
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2.4 ASCET Directories

When installing ASCET, the following directory structure is created on the
installation disk (unless you modify the path settings):

2.4.1 Default Storage Directories

• Database 
ETASData\ASCET6.0\Database

• Export 
ETASData\ASCET6.0\Export
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• Import 
ETASData\ASCET6.0\Export

• generated code 
ETAS\ASCET6.0\CGen 

• automatically generated documentation 
ETASData\ ASCET6.0\Docu

2.4.2 Changing Default Directories

You can use the "Options" dialog window to change the default storage direc-
tories. To do so, proceed as follows:

To change the default storage directories:

• In the Component Manager, select the menu 
option Tools → Options.

The ASCET options window opens. You can 
change the database path in the "Options" 
node, the export/import path in the "Export"/
"Import" node, the code generation path in 
the "Build" node, and the documentation 
path in the "Documentation" node.

• Click on the button next to the path you want 
to change.

The "Path selection" window opens.
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• Specify the directory you want to use as 
default for the selected option.

• Click OK.

The selected directory is displayed in the 
"Options" window.

• Repeat these steps for each option you want 
to change.

• When you are ready, click OK in the 
"Options" dialog to accept the changes, or 
click Cancel to discard the changes.

2.5 Uninstalling ASCET

When ASCET is uninstalled, all add-ons on the computer are uninstalled, too.
You can uninstall only the entire ASCET product family, not separate products
as ASCET-MD, ASCET-SE or ASCET-RP. 

2.5.1 Automatic Uninstall

To uninstall ASCET (automatically):

• From the program group of the start menu, 
select ASCET Uninstall.

The following window is displayed:

• Select Automatic.
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• Click the Next button.

• Click the Finish button to execute the unin-
stall process.
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You can cancel the uninstall process. If you click the Cancel button, the follow-
ing window appears:  

2.5.2 Custom Uninstall

To uninstall ASCET (user-defined):

• From the program group of the start menu, 
select ASCET Uninstall.

The following window is displayed:

• Select Custom.

Note

If data has already been deleted, ASCET must be reinstalled. 
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• Click the Next button.

The "Select Private Files to Remove" window 
opens.

• In the "Select Private Files to Remove" win-
dow, select the files you want to remove.

• Click the Next button.

• In the "Select Directories to Remove" window, 
select the directories you want to remove.

• Click the Next button.

• In the "Select INI Files to Remove" window, 
select the *.ini files you want to remove.

• Click the Next button.

• In the "Select INI Items to Edit" window, select 
the *.ini entries you want to edit.

• Click the Next button.

• In the "Select Registry Keys to Remove" win-
dow, select the registry keys you want to 
remove.

• Click the Next button.

• In the "Select Registry Trees to Remove" win-
dow, select the registry folders you want to 
remove.
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• Click the Next button.

• In the "Select Registry Keys to Edit" window, 
select the registry keys to be edited.

• Click the Next button.

• In the "Select Sub-Systems to Remove" win-
dow, select the sub-systems you want to 
remove.

• Click the Next button.

• In the "Perform Uninstall" window, click the 
Finish button.

• The deinstallation is performed.

You can cancel the custom uninstall process, as well as the automatic deinstal-
lation, using the Cancel button. 

Note

If data has already been deleted, ASCET must be reinstalled. 
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3 Licensing

Products and Add-Ons of the ASCET product family are subject to license man-
agement. In order to work with an ASCET product, after the installation, you
need a license file for your computer. Without this file, ASCET products can be
installed, but you cannot use them.

3.1 Obtaining Licenses

You can obtain the license file required for licensing either from your system
administrator or through a self service portal on the ETAS Internet Site; the URL
is given in the entitlement letter. To request the license file you have to enter
the activation number which you received from ETAS during the ordering pro-
cess.

To obtain the license file:

The license is tied to username and workstation. To obtain the information
required for the creation of the license file, use the ETAS License Manager. 

• In the Windows start menu, select the ETAS 
folder.

• In the ETAS folder, select License 
Management → ETAS License Manager to 
open the ETAS License Manager.

Or

• In the Component Manager, select Help → 
License Info.

• In the "ETAS Licensing" message window, 
click Continue to open the ETAS License Man-
ager.
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The ETAS License Manager contains an entry for each installed ASCET product.
The symbol at the beginning of the entry and the "Status" column entry indi-
cate if a valid license has already been obtained. If available, already installed
licenses for other ETAS products will be listed as well.

• In the ETAS License Manager, select Tools → 
Obtain License Info.

The "Obtain License Info" window opens. It 
shows the MAC and IP addresses for each net-
work board of your computer. 
Licensing



• Select one of the listed Ethernet adapters and 
click on Get License Info.

The information about your computer 
required by ETAS to create a license file are 
collected and displayed in the "License Info" 
window.  

• Click OK to store the information in a text file.

• In the file selection dialog window, enter path 
and name for the text file.

• Click on Save.

The file is created and opened in a text editor. 
Besides your host ID and user name, it con-
tains input lines for your E-mail address, 
license number, and other specifications, as 
well as the ETAS contact addresses.

• Close the "Obtain License Info" window.

• Send the completed text file to ETAS. 

You find the required license number on the 
license contract. You have to send a com-
pleted text file for each ASCET product you 
want to use, e.g. ASCET-MD or ASCET-RP. 

ETAS will send you the license file with the 
required license keys for your computer.

To install the license file:

When you got your license file, proceed as follows to install it.

• Open the ETAS License Manager (cf. page 37).

Note

The license file must not be edited. Otherwise, 
it becomes invalid.
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• In the ETAS License Manager, select File → 
Add Licensing File.

The "Install License" dialog window opens.

• Next to the "Select License File" field click the 
... button.

• In the file selection dialog, select the license 
file for ASCET V6.0 and click Open.

The "Install License" dialog window shows 
information on the selected license.

Note

The "Version" column shows the version num-
ber of the license, not the version number of the 
software.
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• Confirm your selection with OK.

The just added license is now listed in the ETAS 
License Manager. A green symbol before the 
entry shows that the license is valid.

• Click Close to close the ETAS License Man-
ager.

If no valid license file is detected, a trial mode is activated for ASCET-MD,
ASCET-RP or ASCET-SE. That is a limited period of time during which the tool
is fully operational, but a license file is searched regularly, and a warning is
issued when the search fails. 

Add-ons such as INTECRIO-ASC do not have a trial mode. Without a valid
license file, they do not work.

Note

If the green symbol is not displayed, there might 
be a problem with the license file or the license 
relates to another product. Additional informa-
tion on the ETAS License Manager can be found 
in the online help of the ETAS License Manager.
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Once the trial mode is expired, an error message is issued instead of the warn-
ing, and the tool does not work until a valid license is found.

3.2 Borrowing Licenses

When you are using a server license, but need a local license (because, e.g.,
you want to use a notebook in a car), you can borrow the server license for a
limited time. (You do not need to borrow the license as long as you are con-
nected to the server.) The procedure is explained in the online help of the ETAS
License Manager.
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4 ETAS Contact Addresses

ETAS HQ

ETAS GmbH

North America

ETAS Inc.

Japan

ETAS K.K.

Great Britain

ETAS Ltd. 

Borsigstraße 14 Phone: +49 711 89661-0

70469 Stuttgart Fax: +49 711 89661-105

Germany E-mail: sales@etas.de

WWW: www.etasgroup.com

3021 Miller Road Phone: +1 888 ETAS INC

Ann Arbor, MI 48103 Fax: +1 734 997-9449

USA E-mail: sales@etas.us

WWW: www.etasgroup.com

Queen's Tower C-17F Phone: +81 45 222-0900

2-3-5, Minatomirai, Nishi-ku Fax: +81 45 222-0956

Yokohama 220-6217 E-mail: sales@etas.co.jp

Japan WWW: www.etasgroup.com

Studio 3, Waterside Court Phone: +44 1283 54 65 12

Third Avenue, Centrum 100 Fax: +44 1283 54 87 67

Burton-upon-Trent E-mail: sales@etas-uk.net

Staffordshire DE14 2WQ WWW: www.etasgroup.com

Great Britain
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France

ETAS S.A.S.

Korea

ETAS Korea Co. Ltd.

China

ETAS (Shanghai) Co., Ltd.

India

ETAS Automotive India Pvt. Ltd.

1, place des Etats-Unis Phone: +33 1 56 70 00 50

SILIC 307 Fax: +33 1 56 70 00 51

94588 Rungis Cedex E-mail: sales@etas.fr

France WWW: www.etasgroup.com

4F, 705 Bldg. 70-5 Phone: +82 2 57 47-016

Yangjae-dong, Seocho-gu Fax: +82 2 57 47-120

Seoul 137-889 E-mail: sales@etas.co.kr

Korea www.etasgroup.com

2404 Bank of China Tower Phone: +86 21 5037 2220

200 Yincheng Road Central Fax: +86 21 5037 2221

Shanghai 200120 E-mail: sales.cn@etasgroup.com

P.R. China WWW: www.etasgroup.com

No. 690, Gold Hill Square Phone: +91 80 4191 2585

12F Hosur Road, Bommanahalli Fax: +91 80 4191 2586

Bangalore 560 068 E-mail: sales.in@etasgroup.com

India WWW: www.etasgroup.com
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